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Copyright and Legal Notice
Copyright © 1998-2009 Dialogic Corporation. All Rights Reserved. You may not reproduce this document in whole or in 
part without permission in writing from Dialogic Corporation at the address provided below.
All contents of this document are furnished for informational use only and are subject to change without notice and do not 
represent a commitment on the part of Dialogic Corporation or its subsidiaries ("Dialogic"). Reasonable effort is made to 
ensure the accuracy of the information contained in the document. However, Dialogic does not warrant the accuracy of this 
information and cannot accept responsibility for errors, inaccuracies or omissions that may be contained in this document.
INFORMATION IN THIS DOCUMENT IS PROVIDED IN CONNECTION WITH DIALOGIC® PRODUCTS. NO 
LICENSE, EXPRESS OR IMPLIED, BY ESTOPPEL OR OTHERWISE, TO ANY INTELLECTUAL PROPERTY RIGHTS 
IS GRANTED BY THIS DOCUMENT. EXCEPT AS PROVIDED IN A SIGNED AGREEMENT BETWEEN YOU AND 
DIALOGIC, DIALOGIC ASSUMES NO LIABILITY WHATSOEVER, AND DIALOGIC DISCLAIMS ANY EXPRESS OR 
IMPLIED WARRANTY, RELATING TO SALE AND/OR USE OF DIALOGIC PRODUCTS INCLUDING LIABILITY OR 
WARRANTIES RELATING TO FITNESS FOR A PARTICULAR PURPOSE, MERCHANTABILITY, OR 
INFRINGEMENT OF ANY INTELLECTUAL PROPERTY RIGHT OF A THIRD PARTY.
Dialogic products are not intended for use in medical, life saving, life sustaining, critical control or safety systems, or in 
nuclear facility applications.
Due to differing national regulations and approval requirements, certain Dialogic products may be suitable for use only in 
specific countries, and thus may not function properly in other countries. You are responsible for ensuring that your use of 
such products occurs only in the countries where such use is suitable. For information on specific products, contact 
Dialogic Corporation at the address indicated below or on the web at www.dialogic.com.
It is possible that the use or implementation of any one of the concepts, applications, or ideas described in this document, 
in marketing collateral produced by or on web pages maintained by Dialogic may infringe one or more patents or other 
intellectual property rights owned by third parties. Dialogic does not provide any intellectual property licenses with the 
sale of Dialogic products other than a license to use such product in accordance with intellectual property owned or validly 
licensed by Dialogic and no such licenses are provided except pursuant to a signed agreement with Dialogic. More detailed 
information about such intellectual property is available from Dialogic's legal department at 9800 Cavendish Blvd., 5th 
Floor, Montreal, Quebec, Canada H4M 2V9. Dialogic encourages all users of its products to procure all necessary 
intellectual property licenses required to implement any concepts or applications and does not condone or 
encourage any intellectual property infringement and disclaims any responsibility related thereto. These 
intellectual property licenses may differ from country to country and it is the responsibility of those who 
develop the concepts or applications to be aware of and comply with different national license requirements. 
Dialogic, Dialogic Pro, Brooktrout, Diva, Cantata, SnowShore, Eicon, Eicon Networks, NMS Communications, NMS 
(stylized), Eiconcard, SIPcontrol, Diva ISDN, TruFax, Exnet, EXS, SwitchKit, N20, Making Innovation Thrive, 
Connecting to Growth, Video is the New Voice, Fusion, Vision, PacketMedia, NaturalAccess, NaturalCallControl, 
NaturalConference, NaturalFax and Shiva, among others as well as related logos, are either registered trademarks or 
trademarks of Dialogic Corporation or its subsidiaries. Dialogic's trademarks may be used publicly only with permission 
from Dialogic. Such permission may only be granted by Dialogic's legal department at 9800 Cavendish Blvd., 5th Floor, 
Montreal, Quebec, Canada H4M 2V9. Any authorized use of Dialogic's trademarks will be subject to full respect of the 
trademark guidelines published by Dialogic from time to time and any use of Dialogic's trademarks requires proper 
acknowledgement.
Internet Explorer, Microsoft, Windows, Windows NT, and Windows Server are registered trademarks of Microsoft 
Corporation in the United States and/or other countries. Other names of actual companies and products mentioned herein 
are the trademarks of their respective owners.
This document discusses one or more open source products, systems and/or releases. Dialogic is not responsible for your 
decision to use open source in connection with Dialogic products (including without limitation those referred to herein), 
nor is Dialogic responsible for any present or future effects such usage might have, including without limitation effects on 
your products, your business, or your intellectual property rights.
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Hardware Limited Warranty
Warranty for Hardware Products:  Dialogic Corporation or its subsidiary that originally sold the hardware product 
("Dialogic") warrants to the original purchaser of this hardware product, that at the time of delivery the hardware product 
supplied hereunder will be free from defects in material and workmanship.   This warranty is for the standard period set 
out on Dialogic's website at http://www.dialogic.com/warranties and is void if the defect has resulted from accident, 
misuse, abuse or misapplication.  Any hardware product which becomes defective during the warranty period and is 
returned by the original purchaser to Dialogic's Authorized Service Center with a Return Material Authorization (RMA) 
number (which must be obtained from Dialogic before any return) within thirty (30) days after discovery of the defect with 
a written description of the defect will be repaired or replaced at Dialogic's option. Freight charges will be paid by Dialogic 
only for shipment back to you.

Additional Exclusions:  Dialogic will have no obligation to make repairs or replacements necessitated by your fault or 
negligence, improper or unauthorized use of the product, repairs or modifications made without Dialogic's prior written 
approval or by causes beyond the control of Dialogic, including, but not limited to, power or air conditioning failure, acts 
of God, improper interface with other units, or malfunction of any equipment or software used with the Dialogic product(s). 
If Dialogic is requested and agrees to make repairs or replacements necessitated by any such causes, you will pay for such 
service or replacement at Dialogic's then prevailing rates. 

No Other Warranties:  DIALOGIC DISCLAIMS AND YOU WAIVE ALL OTHER WARRANTIES, EITHER EXPRESS 
OR IMPLIED, INCLUDING BUT NOT LIMITED TO IMPLIED WARRANTIES OF MERCHANTABILITY, NON-
INFRINGEMENT AND FITNESS FOR A PARTICULAR PURPOSE AND ANY WARRANTY AGAINST LATENT 
DEFECTS, WITH RESPECT TO ANY DIALOGIC PRODUCT.  

No Liability for Damages:  IN NO EVENT SHALL DIALOGIC OR ITS SUPPLIERS BE LIABLE FOR ANY DAMAGES 
WHATSOEVER (INCLUDING, WITHOUT LIMITATION, DAMAGES FOR LOSS OF PROFITS, INTERRUPTION OF 
ACTIVITIES, LOSS OF INFORMATION OR OTHER PECUNIARY LOSS AND DIRECT OR INDIRECT, 
CONSEQUENTIAL, INCIDENTAL, ECONOMIC OR PUNITIVE DAMAGES) ARISING OUT OF THE USE OF OR 
INABILITY TO USE ANY DIALOGIC PRODUCT. 

Limitation of Liability: DIALOGIC'S MAXIMUM CUMULATIVE LIABILITY SHALL BE LIMITED TO THE 
AMOUNTS ACTUALLY PAID BY YOU TO DIALOGIC FOR THE SPECIFIC PRODUCT BEING THE OBJECT OF THE 
CLAIM.  YOU RELEASE DIALOGIC FROM ALL AMOUNTS IN EXCESS OF THE LIMITATION.  YOU  
ACKNOWLEDGE THAT THIS CONDITION IS ESSENTIAL AND THAT DIALOGIC WOULD NOT SUPPLY TO YOU 
IF IT WERE NOT INCLUDED.

.
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END USER SOFTWARE LICENSE AGREEMENT 
*** IMPORTANT *** 
IF YOU HAVE RECEIVED THE ACCOMPANYING SOFTWARE AS A PHYSICAL MEDIA IN AN 
ENCLOSED PACKAGE, PLEASE READ CAREFULLY BEFORE OPENING THE ENCLOSED 
PACKAGE.  IF YOU HAVE ARE ACCESSING THE SOFTWARE ELECTRONICALLY, PLEASE 
READ CAREFULLY BEFORE DOWNLOADING, INSTALLING OR USING THE SOFTWARE. 
This End User License Agreement is a legal agreement between Dialogic Corporation and its 
subsidiaries (collectively, “Dialogic”) and you (either an individual or an entity) (“End User” or “You”). 
TIF YOU HAVE A WRITTEN, SIGNED LICENSE AGREEMENT GOVERNING THE USE OF 
THE ACCOMPANYING SOFTWARE (“SOFTWARE”), THE TERMS AND CONDITIONS OF 
THAT AGREEMENT WILL APPLY TO YOUR USE OF THE SOFTWARE. IF YOU HAVE A 
WRITTEN, SIGNED SOFTWARE DEVELOPMENT LICENSE EXCLUSION GOVERNING THE 
USE OF THE SOFTWARE (“SPECIAL TERMS”), THOSE SPECIAL TERMS ARE HEREBY 
INCORPORATED INTO THIS AGREEMENT. T 

READ THE FOLLOWING TERMS AND CONDITIONS CAREFULLY AND ENTIRELY, AS THEY 
DEFINE YOUR RIGHTS AND OBLIGATIONS WITH RESPECT TO THE SOFTWARE. IF YOU ARE 
ACCESSING THE SOFTWARE ELECTRONICALLY, YOU MUST INDICATE YOUR ACCEPTANCE 
OF THESE TERMS AND CONDITIONS BY CLICKING ON OR OTHERWISE SELECTING THE 
"ACCEPT" OR “AGREE” BUTTON OR ICON AT THE END OF THIS AGREEMENT.  IF YOU DO 
NOT ACCEPT THE TERMS AND CONDITIONS OF THIS AGREEMENT AND YOU ARE 
ACCESSING THE SOFTWARE ELECTRONICALLY, SELECT THE "DECLINE" OR “DO NOT 
ACCEPT” BUTTON OR ICON AT THE END OF THIS AGREEMENT.  IF, INSTEAD, YOU 
RECEIVED THE SOFTWARE ON A PHYSICAL MEDIA, THEN BY OPENING THE ENCLOSED 
PACKAGE THAT INCLUDES THE SOFTWARE, YOU “ACCEPT” OR “AGREE TO” THE TERMS 
AND CONDITIONS OF THIS AGREEMENT.  IF YOU RECEIVED THE SOFTWARE ON A 
PHYSICAL MEDIA AND DO NOT ACCEPT THE TERMS AND CONDITIONS OF THIS 
AGREEMENT, YOU MAY RETURN THE ENCLOSED PACKAGE UNOPENED TO THE PLACE OR 
PARTY FROM WHICH YOU OBTAINED IT FOR A FULL REFUND. 
BY DOWNLOADING, INSTALLING, COPYING OR OTHERWISE USING THE SOFTWARE, 
WHETHER IN ELECTRONIC FORM OR ON A PHYSICAL MEDIA, YOU FURTHER AGREE THAT 
YOU HAVE READ THIS AGREEMENT AND UNDERSTAND IT, AND THAT BY TAKING ANY ONE 
OR MORE OF SUCH STEPS YOU AGREE TO BE BOUND BY THE TERMS AND CONDITIONS OF 
THIS AGREEMENT.  DIALOGIC IS UNWILLING TO LICENSE THE SOFTWARE TO YOU IN ANY 
FORM IF YOU DO NOT ACCEPT AND AGREE TO BE BOUND BY THE TERMS AND CONDITIONS 
OF THIS AGREEMENT.   



AN INDIVIDUAL WHO DOES NOT HAVE AUTHORITY TO BIND THE END USER THAT IS USING THE 
SOFTWARE SHOULD NOT USE THE SOFTWARE WITHOUT OBTAINING APPROVAL OF THIS 
AGREEMENT FROM A PERSON HAVING SUCH AUTHORITY. 

YOU UNDERSTAND THAT, IF YOU PURCHASED THE SOFTWARE (WITH OR WITHOUT 
RELATED DIALOGICP

®
P HARDWARE OR ADDITONAL SOFTWARE) FROM AN AUTHORIZED 

RESELLER OF DIALOGIC, THAT RESELLER IS NOT DIALOGIC’S AGENT AND IS NOT 
AUTHORIZED TO MAKE ANY REPRESENTATIONS, CONDITIONS OR WARRANTIES, 
STATUTORY OR OTHERWISE, ON DIALOGIC'S BEHALF NOR TO VARY ANY OF THE TERMS OR 
CONDITIONS OF THIS AGREEMENT. IN ADDITION, YOU ACKNOWLEDGE THAT, UNLESS 
OTHERWISE AGREED BY THAT RESELLER IN WRITING OR PROHIBITED BY LAW, THE 
LIMITATIONS OF CONDITIONS AND WARRANTIES, STATUTORY OR OTHERWISE, AND 
LIABILITY SET FORTH IN THIS AGREEMENT ALSO APPLY TO AND BENEFIT THAT 
RESELLER. 
 



TThe Software may include object code versions of third party software packages, including one or more 
of the following, which are subject to the terms and conditions of the applicable license agreements 
found at the websites identified below.  
TACE(TM), TAO(TM), CIAO(TM), and CoSMIC(TM) (henceforth referred to as "DOC software") are 
copyrighted by Douglas C. Schmidt and his research group at Washington University, University of 
California, Irvine, and Vanderbilt University, Copyright (c) 1993-2008, all rights reserved. More 
information is available at:T  

T http://www.cs.wustl.edu/~schmidt/ACE.htmlT 

TwxWidgets software is copyrighted by Julian Smart, Robert Roebling et al. 
Copyright (c) 1998 Julian Smart, Robert Roebling et al. More information is available at: 

T http://www.wxWidgets.org 
TPortions of the Software are licensed under the Apache License, Version 2.0 (the "Apache License"); you 
may not use this file except in compliance with the Apache License. You may obtain a copy of the 
Apache License at: 
   http://www.apache.org/licenses/LICENSE-2.0T 

TUnless required by applicable law or agreed to in writing, software distributed under the Apache 
License is distributed on an "AS IS" BASIS, WITHOUT WARRANTIES OR CONDITIONS OF ANY 
KIND, either express or implied. See the Apache License for the specific language governing 
permissions and limitations under the Apache License.T 

TPortions of this software are © 1996-2009_ RADVISION Ltd. All intellectual property rights in such 
portions of the Software and documentation are owned by RADVISION and are protected by United 
States copyright laws, other applicable copyright laws and international treaty provisions. RADVISION 
and its suppliers retain all rights not expressly granted. 
TPortions of this software are COPYRIGHT 1989-2004 NETBRICKS SAS- ALL RIGHTS RESERVEDT" T 

1.  Definitions 
1.1.  “UDialogic HardwareU” means voice and/or fax processing hardware and/or any other computer 

hardware manufactured by or for Dialogic which may (without limitation) be marketed under 
the brands Dialogic, Brooktrout, Excel, and/or Snowshore and purchased by the End User 
from Dialogic or one of its authorized resellers. 
“ULicense Key U” means an access code or activation key provided by Dialogic or one of its authorized 

reseller to enable End User to use the Software.  
1.1.  “USoftware U” means the software provided to you in the enclosed package or enabled by the 

enclosed License Key, together with any accompanying documentation.  
2.  License 
2.1 UGrantU. Subject to the terms of this Agreement, Dialogic grants to End User a limited, non-exclusive, 

non- transferable license (without the right to sublicense), to use the Software in accordance with 



the following provisions: (a) if the Software is provided to End User for use with Dialogic Hardware, 
to use the Software solely in connection with Dialogic Hardware for End User’s internal business 
purposes and (b) if the Software is provided as host-based media processing software, to use the 
Software solely in connection with End User’s internal business purposes, provided that End User 
purchases a License Key. The Software is used in connection with Dialogic Hardware if it is 
operated only on the central processing unit of a computer served by one or more items of Dialogic 
Hardware and, where appropriate in connection with such use, it is downloaded into memory 
located on Dialogic Hardware. 

2.2U CopiesU. End User shall not copy the Software, except as permitted under applicable law, and then 
only with the inclusion of all copyright, proprietary and other notices.  

2.3U No Reverse EngineeringU. End User shall have no rights to any source code for the Software. End 
User agrees that it shall not cause or permit the disassembly, decompilation or reverse engineering 
of the Software or otherwise attempt to gain access to the source code to the Software. If applicable 
law requires access to source code for some purpose, such as inter-operability with other software, 
and End User desires access for that required purpose, End User shall notify Dialogic, and Dialogic 
shall have the option, in its discretion, to (i) perform the work to derive any required information at 
Dialogic’s usual consulting rate, or (ii) allow End User access to source code solely for the legally 
required purpose. 

2.4U Additional RestrictionsU. End User shall not, and shall not permit any third party to disclose the 
results of any benchmark test of the Software to a third party without the prior written approval of 
Dialogic. 

2.5  UReservation of RightsU. Dialogic and its licensors reserve all rights not otherwise expressly granted 
in this Section 2. Any use, modification, reproduction or distribution of the Software not expressly 
permitted under this Agreement is herby expressly prohibited. 

2.6 ULicense KeysU. The use of the Software may require a License Key from Dialogic. End User shall not 
(a) use any access code or activation key other than the License Key (if any) provided by Dialogic or 
(c) develop or alter any access code for the Software or otherwise circumvent or attempt to 
circumvent the License Key.  

2.7  Upgrades, Updates, Etc. Unless otherwise agreed to in a separate agreement, End User shall have 
no right to receive any corrections, enhancements, upgrades, maintenance releases or other 
modifications to the Software (“Changes”). For clarity, End User acknowledges that if it is a party to 
Dialogic’s Software Developer License Agreement and/or Master Software  
Maintenance Agreement, and it receives Changes under either of those agreements, End User shall 
have no right to use those Changes under this End User Software License for its internal business 
purposes unless End User has entered into a separate maintenance agreement for the Software and 
has paid Dialogic the applicable maintenance fee.  



3. Purchase of License Key  

If the Software is distributed to End User as host-based media software, End User shall purchase a 
License Key from Dialogic or its authorized reseller.  
 

4. Ownership  
4.1 Dialogic or its licensors own and shall retain all proprietary rights, including all patent, 

copyright, trade secret, trademark and other intellectual property rights, in and to the Software 
and any modifications thereto made by any entity.  

4.2 Unless End User enters into a separate agreement with Dialogic or its authorized reseller 
which entitles End User to receive maintenance and support services, End User shall have no 
right to receive any corrections, enhancements, upgrades or other modifications to the Software 
(“Changes”).  

4.3  End User acknowledges that the license granted under this Agreement does not provide End 
User with title to or ownership of the Software, but only a right of limited use under the terms 
and conditions of this Agreement. End User shall keep the Software free and clear of all claims, 
liens and encumbrances.  

5.  Limited Warranty 
5.1U Scope of Limited WarrantyU 

a.  Dialogic warrants to End User that for a period of ninety (90) days from delivery of the 
Software to End User (the “Software Warranty Period”), the Software will substantially 
perform in accordance with its documentation. Dialogic’s sole liability and End User’s 
exclusive remedy under this limited warranty shall be (i) the repair or replacement of the 
non-conforming Software or, (ii) at Dialogic’s option, in the case of Software licensed under 
Section 2.1(a) the refund of the price paid by End User for the Dialogic Hardware or, in the 
case of host-based media processing software licensed under Section 2.1(b), the refund of the 
price paid by End User for the License Key.  

b.  The remedies set forth in Section 5.1(a) are available only if Dialogic is promptly notified in 
writing, within the applicable warranty period, upon discovery of the non-conformity by End 
User, and Dialogic’s examination of the Software and/or Dialogic Hardware discloses that 
such non-conformity exists. This limited warranty shall not apply if the Software or Dialogic 
Hardware has been: (i) altered or modified; (ii) subjected to negligence, computer or 
electrical malfunction; or (iii) used, adjusted, installed or operated other than in accordance 
with instructions furnished by Dialogic or with an application or in an environment other 
than that intended or recommended by Dialogic.

5.2U Disclaimer of Any Other WarrantiesU. EXCEPT FOR THE EXPRESS, LIMITED WARRANTY 
PROVIDED IN SECTION 5.1, DIALOGIC MAKES NO WARRANTIES, EITHER EXPRESS OR 
IMPLIED, WITH RESPECT TO THE SOFTWARE, AND DIALOGIC DISCLAIMS ALL 
IMPLIED WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR 



PURPOSE AND NONINFRINGEMENT. DIALOGIC DOES NOT WARRANT THAT THE 
SOFTWARE WILL BE UNINTERRUPTED OR ERROR-FREE, OR THAT IT WILL SATISFY 
END USER’S REQUIREMENTS. 



6. Limitation of Liability  
6.1  IN NO EVENT SHALL DIALOGIC’S OR ITS LICENSORS’ AGGREGATE LIABILITY ARISING UNDER 

THIS AGREEMENT EXCEED THE AMOUNTS PAID BY END USER TO DIALOGIC HEREUNDER.  

6.2 IN NO EVENT WILL DIALOGIC OR ITS LICENSORS BE LIABLE TO END USER FOR 
SPECIAL, INCIDENTAL, CONSEQUENTIAL, EXEMPLARY, PUNITIVE, MULTIPLE OR 
OTHER INDIRECT DAMAGES, OR FOR LOSS OF PROFITS, LOSS OF DATA OR LOSS OF 
USE DAMAGES, ARISING OUT OF THIS AGREEMENT, WHETHER BASED UPON 
WARRANTY, CONTRACT, TORT, STRICT LIABILITY OR OTHERWISE, EVEN IF 
DIALOGIC HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES OR 
LOSSES. 
  

7. Term and Termination 
7.1 UTermination U. Dialogic shall have the right to terminate this Agreement and the license granted 

herein in the event End User fails to comply with any of the terms and conditions of this 
Agreement and such default has not been cured within thirty (30) days after written notice of 
such default. 

7.2U Effect of TerminationU. Upon termination of this Agreement, all licenses and other rights 
granted under this Agreement will become null and void. Within five (5) days after termination 
of this Agreement, End User shall return to Dialogic or destroy, at End User’s expense, the 
Software, including all copies thereof. Sections 2.2- 2.6 and 4-10 shall survive termination of 
this Agreement.  

8. U.S. Government Restricted Rights  

If Software is acquired by or on behalf of a unit or agency of the United States government, 
the Software is provided as “commercial computer software” or “commercial computer software 
documentation” and, absent a written agreement to the contrary, the government’s rights with 
respect to such Software are limited by the terms of this Agreement pursuant to FAR Paragraph 
12.212(a) and/or DFARS Paragraph 227.7202-1(a), as applicable. 

9. UExport U  

End User shall comply with all export and re-export restrictions, laws and regulations of the U.S. 
Commerce Department and other U.S. agencies and authorities. 

10.0U General U  
10.1U AssignmentU. This Agreement shall be binding upon and inure to the benefit of the parties hereto, 

and their respective successors and permitted assigns. End User shall not assign or otherwise 
transfer this Agreement or any rights or obligations hereunder, in whole or in part, whether by 
operation of law or otherwise, without Dialogic’s prior written consent. Any purported transfer, 
assignment or delegation without such prior written consent will be null and void and of no force or 
effect.  

 



10.2U Entire AgreementU. This Agreement, together with any Special Terms, represents the entire 
agreement between the parties, and supersedes all prior agreements and understandings with 
respect to the matters covered by this Agreement. In the event of a conflict between this 
Agreement and the Special Terms, the Special Terms shall control. End User agrees that it has not 
entered in this Agreement based on any representations other than those contained herein. No 
modification of or amendment to this Agreement, nor any waiver of any rights under this 
Agreement, shall be effective unless in writing signed by the party to be charged. 

10.3U Governing Law U. This Agreement shall in all respects be governed by the laws of the 
Commonwealth of Massachusetts, excluding: (i) its conflicts of laws principles; (ii) the United 
Nations Convention on Contracts for the International Sale of Goods; (iii) the 1974 Convention on 
the Limitation Period in the International Sale of Goods; and (iv) the Protocol amending the 1974 
Convention, done at Vienna April 11, 1980. 

10.4U Severability U. If any of the provisions of this Agreement is held by a court of competent jurisdiction 
to be invalid under any applicable statute or rule of law, such provision shall, to that extent, be 
deemed omitted, and the remaining portions of this Agreement shall remain in full force and effect. 

10.5U Waiver U. The waiver of one breach or default or any delay in exercising any rights shall not 
constitute a waiver of any subsequent breach or default.  

10.6U NoticesU. All notices permitted or required under this Agreement shall be in writing and shall be 
delivered in person or mailed by first class, registered or certified mail, postage prepaid, to the 
address of the party specified on the first page of this Agreement or such other address as either 
party may specify in writing. Such notice shall be deemed to have been given upon receipt.  

10.7 UHeadingsU. The headings are for convenience and shall not be used to construe this Agreement.  
10.8 UNo Agency; Independent ContractorsU. Nothing contained in this Agreement shall be deemed to 

imply or constitute that either party is the agent or representative of the other party, or that both 
parties are joint ventures or partners for any purpose. 

 
License part number: 931-122-11 
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About this Publication

Introduction

This Dialogic® Brooktrout® SR140 Fax Software User Guide is for 
users running the SR140 Fax Software in a Windows® environment.

Refer to the Dialogic® Brooktrout® SR140 Fax Software Linux User 
Guide if you operate in a Linux environment.

This document contains the following:

Chapter 1 explains how you get started.

Chapter 2 describes how to activate Dialogic® Brooktrout® fax 
products using the Dialogic® Brooktrout® License Manager.

Chapter 3 describes how to configure the Dialogic® Brooktrout®  
Fax Software.

Chapter 4 explains testing the Dialogic® Brooktrout® SR140.

Chapter 5 provides virtual model specifications.

Manual Conventions

This manual uses the following conventions:

Italics denote the names of variables in the prototype of a 
function, and file names, directory names, and program names 
within the general text.

The Courier font in bold indicates a command sequence entered 
by the user at the system prompt, for example:

cd /Brooktrout/boston/bfv.api
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The Courier font not bolded indicates system output, for 
example: 

C:>Files installed.
The Courier font also denotes programming code, such as C and 
C++. Programming code appears in program examples.

Bold indicates the data type of the prototype of a function, 
Dialogic® Brooktrout® Bfv API functions, dialog boxes, dialog 
box controls, windows, and menu items.

Square brackets [ ] indicate that the information to be typed is 
optional.

Angle brackets < > indicate that you must supply a value with the 
parameter.

.

The Caution icon is used to indicate an action that could cause harm to 
the software or hardware.

The Warning icon is used to indicate an action that could cause harm to 
the user.
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Related Documents
Related Documents
For product information, white papers, FAQs, and more, access the 
Dialogic web site at www.dialogic.com.
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System Requirements for the Dialogic® Brooktrout® SR140 Fax Software
System Requirements for the Dialogic® Brooktrout® 
SR140 Fax Software

Minimum System Requirements

The minimum system requirements for running any number of 
SR140 channels is a Pentium P4 2.66 GHz with 512MB RAM. 

Supported and Tested Devices for Interoperability

For the latest listing of Dialogic® Brooktrout® FoIP interoperability 
information refer to the following site:

http://www.dialogic.com/interoperability/fax.htm

This list includes the following hardware devices (and their 
respective software revisions) that have been tested for 
interoperability with the SR140 Fax Software:

IP PBX

Gateways

Other devices
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System Requirements for the Dialogic® Brooktrout® SR140 Fax Software
Telephony Requirements

Supported Operating Systems

A supported operating system is one for which the Dialogic® 
Brooktrout® Fax Software has been designed and tested. The 
following operating systems are supported for the Dialogic® 
Brooktrout® SDK Version 6.1:

Windows® 2000 Professional, Service Pack 4 and Windows® 
Update 822831 (see Note).

Windows® 2000 Server, Service Pack 4 and Windows® Update 
822831 (see Note).

Windows® 2000 Advanced Server, Service Pack 4.

Windows® XP Professional, Service Pack 2.

Windows Server® 2003, Standard Edition, Service Pack 2

Windows Server® 2003, Enterprise Edition, 32-bit version, 
Service Pack 2

Windows Server® 2003 x64 Editions, Service Pack 2 
x86-64, Intel 64-Bit Xeon; Intel Pentium with EM64T

Windows Server® 2008

Note: Because a Windows® defect was introduced with Service Pack 
4, use Windows® Update 822831 to assist in software 
installation.

The Microsoft hotfix 909666 is required when running 
Windows Server® 2003 x64. Obtain the hotfix from Microsoft 
at http://support.microsoft.com/ by referencing the 
knowledge base number 909666. System crashes can occur 
without this hotfix.

Physical Media Call Control

Ethernet 10/100 T.38 v0

RTP V2 G.711

H.323
SIP 
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System Requirements for the Dialogic® Brooktrout® SR140 Fax Software
Terminology

Updated Terminology

The current version of this document includes terminology that 
differs from previous versions. Please note the changes below:

Former Terminology Replaced with...

Host-based fax Dialogic® Brooktrout® SR140 Fax Software

or 

Brooktrout SR140 Fax Software 

or

SR140 Software

or

SR140

Virtual modules

Virtual boards

Software modules

VoIP modules

SR140 virtual modules

TR1000 Series SDK Dialogic® Brooktrout® SDK

TR1000 Series Product Dialogic® Brooktrout® Fax Board 

or 

Brooktrout fax board

or

board

TR1000 Series Module

TR1000 Series Board

Brooktrout System Software Dialogic® Brooktrout® Runtime Software
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System Requirements for the Dialogic® Brooktrout® SR140 Fax Software
Dialogic® Brooktrout® TR1034 Fax Board Terminology
The Dialogic® Brooktrout® TR1034 Fax Board is also referred to 
herein by one or more of the following terms, or like terms including 
“TR1034”:

Brooktrout TR1034 Fax Board

Brooktrout TR1034 Board

TR1034 Fax Board

TR1034 Board

TR1034
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Getting Technical Support
Getting Technical Support

Dialogic provides technical support and services for customers who 
have purchased hardware or software products from Dialogic. If you 
purchased products from a reseller, please contact that reseller for 
technical support.

To obtain technical support, please use one of the following methods:

Web: www.dialogic.com/support/default.asp

Phone: North America: +1 781-433-9600

Belgium: +32 2-658-5170

Japan: +81 3-3234-2176
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1 - Getting Started 

This chapter provides an introduction and quick start installation 
instructions for installing the Dialogic® Brooktrout® software in a 
Windows® environment.

Refer to the Dialogic® Brooktrout® SR140 Fax Software Linux User 
Guide if you operate in a Linux environment.
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Introduction
Introduction

What is a Virtual Module?

Dialogic’s intelligent fax board platform, the Dialogic® 
Brooktrout®TR1034 Fax Board, provides Dialogic ISV (Integrated 
Software Vendor) partner’s fax application with the capability to 
communicate from their application to the telephone or IP network. 
For software-only systems using IP only, Dialogic has implemented 
the SR140 as a virtual module. Although it is software, the SR140 
appears to the fax application just like a board. That helps simplify 
your fax application publisher to provide a single product that works 
for hardware and software.

What is a Software License?

The SR140 Virtual Module is delivered inside your fax application. 
The SR140 license is the right to use the software products in an 
entitlement purchased from Dialogic. The license is represented by 
the contents of a License File that is used by the software to restrict 
use to that entitlement. When you install the software, you 
acknowledge the License Agreement that governs SR140 licensing. 
Your License is delivered in paper form and shows you what your 
entitlement is, and provides a License Key to allow you to apply your 
entitlement to a computer system when you install the SR140 Fax 
Software.

Make sure to keep your License Key certificate in a safe place, where 
you can find it easily.

What is Product Activation?

As well as helping you stay within your entitlement, your SR140 Fax 
Software product uses copy protection technology. Following 
installation of the software, Product Activation is a process for tying 
a license to a particular system, limiting use of that licensed 
software to one computer system. Product Activation is simple and 
may be completed via the Internet, email or by fax and involves 
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Introduction
supplying your License Key shown on the License Key certificate and 
a unique identifier of the computer system that can be used to lock a 
license to a computer (known as node-locking).

What is Configuration?

All modules - virtual modules or real boards - need to know how to 
handle call control over the IP network. Once you have installed the 
software and activated your product, you need to enter settings that 
control how connections are made between the IP network and the 
virtual module. This process is called configuration.

What is Involved in Getting it Working?

Supported Operating System

For a list of supported operating systems see Supported 
Operating Systems on page 19.

Installation

For more information see Verifying Software Installation on 
page 5.

Product Activation

For more information see Using the License Manager to Activate 
Brooktrout Products on page 9.

SR140 Configuration

For more information see Configuring Dialogic® Brooktrout® 
SR140 Software on page 61.

IP Configuration

For more information see IP Call Control Modules on page 108.

Test

For more information see Testing the Dialogic® Brooktrout® 
SR140 Fax Software on page 123.
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Quick Start Steps
Quick Start Steps

When doing the installation, you need:

Administrative privileges for the server

and either of the following:

Windows® 2000

Windows Server® 2003

Windows® XP

Windows Server® 2008

Use the installation program provided with your application 
software to install the software for the SR140.
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2 - Activating Dialogic® Brooktrout®
Products

This chapter describes how to activate a license for the Dialogic® 
Brooktrout® SR140 Fax Software.

The SR140 Fax Software functionality is protected against piracy 
and abuse by licensing technology that uses product activation. A 
License Key is sold to the user who exchanges the key for a license 
file during or after installing the software. The license file is tied to 
the system during activation by imprinting a unique system 
signature (a Node ID) on the license file, and is based on the 
machine's MAC address.

The License Key can either be a unique, paid-for license key that 
provides a perpetual license or a demo license key that results in 
software that provides limited support for a limited time. Both types 
of product - licensed as demo or paid-for - require activation. You 
have several ways to activate the product.

You can use the Dialogic® Brooktrout® License Manager application 
to verify information about current licenses and to add new licenses 
for your Dialogic® Brooktrout® products.
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The application also verifies the following:

The signature of the license is not broken.
The license is not expired.
The Node ID of the license matches the Node ID of the computer 
(sometimes referred to as the “Node Lock” of the computer).
The system clock is not set back.

Please contact Dialogic Technical Services and Support if you are 
unable to use the license. See Getting Technical Support on page 22.

This document has the following sections:

Preparing for Activation on page 29.
Using the License Manager on page 30.
Activating a License Automatically on page 35.
The Product Registration window appears: on page 36.
Activating a License Using the Web on page 39.
Activating a License Using Email or Fax on page 45.
Installing Licenses on page 47.
Logging Information on page 49.
Managing License Files on page 50.
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Preparing for Activation
Preparing for Activation

To use the License Manager to activate your Brooktrout product, 
perform the activation process from the system where the Dialogic® 
Brooktrout® SR140 Fax Software is installed. Once the license is 
activated, install the license file on that system (unless you activate 
automatically which does not require installation). 

Because the SR140 Fax Software is an IP-based technology, Dialogic 
uses the IP network and the Internet to perform Product Activation. 
Ideally, the system you are installing on should be connected to an 
IP Network and to the Internet.

However you activate, Dialogic strongly recommends that you 
archive the License Certificate and the License File once the product 
has been activated.

Automatic activation must be performed using the License Manager 
on the system which is to be licensed.

Note: Because the license verifies if the system clock has been set 
back, you should ensure that the system date is set correctly.
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Using the License Manager
Using the License Manager

The License Manager application is usually installed with your fax 
application.

To start the License Manager, use one of the following methods:

Start the License Manager from the Configuration Tool

Select Start → Program Files → Brooktrout →  
Brooktrout License Manager
If you accepted the standard location to install your software, 
double-click the brktlicmgr.exe file at the following location:
C:\Brooktrout\Boston\bin

Otherwise, go to the location where you chose to install the 
software and double-click the brktlicmgr.exe file.

The License Manager window appears. 

This window shows information for any installed licenses. The 
application tries to determine license integrity and authenticity.
Typical problems when validating licenses:
1. The license can have a broken signature.
2. The license can expire.
3. The license can have the wrong Node ID.
4. System clock can be tampered.
If the license has more than one problem, only the first detected 
problem is indicated. For example, if the license has expired and 
has a broken signature, only the broken signature is indicated on 
the main screen.
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Using the License Manager
Displaying and Copying Node IDs

There may be more than one MAC address on the system. If so, you 
can choose the MAC address in which to lock. The License Manager 
allows you to view the Node ID representation of the first 20 
Ethernet Adapter MAC addresses available on the system. 

You need to use this function in order to node lock to a MAC address 
in the system other than the default MAC address used for node 
locking. 

For information on node locking refer to Overriding the Default MAC 
Address Used for Node Locking on page 38.

Follow the steps below:

1. From the Utilities menu, select Display all node IDs. A screen like 
the following appears.:

2. Double-click to select the Node ID. Right click and select Copy to 
copy the Node ID.
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Using the License Manager
Displaying and Copying Node ID 

 Follow the steps below to display and copy a Node ID 
(referred to as Node Lock in the screen below).

1. From the Utilities menu, select Display Node Lock. A screen like 
the following appears:

2. Double-click to select the Node ID. Right click and select Copy to 
copy the Node ID.
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Starting the License Activation Wizard
Starting the License Activation Wizard

Start up the License Activation Wizard by selecting Activate License 
from the License menu.

1. Select License -> Activate License. 

2. Click Next. The Activation Method dialog box appears:
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Starting the License Activation Wizard
3. Select an Activation Method.

Automatically (this computer is connected to the Internet)

Activates licenses automatically to the machine performing 
the activation. This is the easiest method if your computer is 
connected to the Internet. If successful, this step completes 
the product activation process immediately. Your new license 
files are displayed in the License Manager main window.

See Activating a License Automatically on page 35.

Using the interactive web method

Activates licenses using the Dialogic License Activation 
website. After successfully processing activation information, 
you can choose to download the file immediately or have the 
license emailed to you. Within a couple of minutes Dialogic 
sends an email containing a license file, if you select to have 
the license emailed to you. To complete the activation process, 
use the License Manager interface to install the license file(s) 
on the machine specified. 

See Activating a License Using the Web on page 39.

Create a request for email or fax

See Activating a License Using Email or Fax on page 45. After 
successfully processing activation information, Dialogic 
sends an email containing a license file. To complete the 
activation process, use the License Manager interface to 
install the license file(s) on the machine specified in the 
email/fax activation request. Dialogic sends a license in about 
one working day.
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Activating a License Automatically
Activating a License Automatically

To activate a Brooktrout license using the automatic 
activation method, follow the steps below:

1. Select the automatic activation option above.

The License Keys dialog appears:

2. Select the Add button to enter all purchased License Keys one at 
a time.  
You can enter more than one License Key. You must enter at least 
one License Key to proceed, otherwise an Error dialog box 
appears.

This License Key can be found on your Licence certificate. The 
License Key is a variable length ASCII string. An example of such 
a key is: BRKT111-1234567

Note: Click the Edit button if you need to correct the License Key 
information. Click the Delete button if you need to delete 
license key information. 
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Activating a License Automatically
3. The Please enter License Key dialog box appears:

4. Enter the License Key and Click OK.

5. The Product Registration window appears:

For your convenience, Product Registration follows activation in the 
same session using the License Activation Wizard. 

6. Follow the screen prompts if the Product Registration window 
appears.

All but one of the registration fields are required (indicated by an 
asterisk [*]). When required information is not entered, an Error 
dialog box is displayed. Be sure to enter the information for the 
person responsible for the day-to-day running of the installation.
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Activating a License Automatically
7. Verify that your computer is connected to the Internet.

8. Click Next to begin processing your license request.

The License Manager sends the license request to the Dialogic 
License Activation Center, where your license request is 
processed.
The request process can take a few minutes.

9. The Request Status window appears when the automatic 
activation process is complete and one of the following messages 
appears:

License Obtained

The requested license is automatically installed in your 
system. The product activation process is complete.

License Key invalid

The License Manager provides a Tip when license activation 
fails. The Tip usually provides a possible solution, or where to 
get more information that leads to a solution.

When a License Key is invalid because of a data-entry error, 
re-enter the correct license key by running the License 
Activation Wizard again. If the license key has been entered 
correctly but the request status is invalid, contact Dialogic 
Technical Services and Support. See Getting Technical 
Support on page 22.

Request failed

When you attempt to activate a license key for the second 
time from the same or another computer, it is considered 
re-hosting. Please contact Dialogic Technical Services and 
Support for solutions to this problem. See Getting Technical 
Support on page 22.

Also see Managing License Files on page 50 for more 
information.
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Activating a License Automatically
Activation Center unavailable

The License Activation Center cannot be reached because the 
License Activation Center computer is temporarily 
unavailable or you are experiencing temporary Internet 
problems.

Attempt to correct the problem and retry the request. When 
using the access numbers, if failures persist, contact Dialogic 
Technical Services and Support. See Getting Technical 
Support on page 22.

10. Click Next. 
The Thank you... window appears:

11. Click Finish to complete your activation process.

Because you activated automatically, you do not need to install 
licenses. Your activation process is finished.

Overriding the Default MAC Address Used for Node Locking 

Note: The follow procedure applies only to automated license 
activation.

In some cases, when you have multiple MAC addresses in your 
system, you may want to use a different MAC address other than the 
default MAC address used for node locking.

Create a file named brktlicmgr.cfg and place it in the same directory 
as the License Manager (for example Brooktrout\boston\bin). 

This file should be a text file with a single line 
 ‘NodeID=<enter node id here>’, with no spaces.

To obtain the node ID for the MAC address you intend to 
use follow the steps below.

1. Launch the License Manager.

2. From the Utilities menu, Select Display All Node Ids option.

3. Select the adapter.

4. Copy and paste into the brktlicmgr.cfg configuration file.

For details see Displaying and Copying Node IDs on page 31.
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Activating a License Using the Web
Activating a License Using the Web

You can also activate your SR140 Fax Software license on the web 
using a computer that has web access. This can be a different 
computer than the server on which you are installing the SR140 
virtual module.

It is critical that you enter the Node Lock information for the intended 
machine (Node ID) on the website without errors. The software 
generates an unusable license when you enter incorrect Node Lock 
information. The second attempt to obtain the license using the corrected 
Node Lock information is considered re-hosting. In this case see 
Re-Hosting License Files on page 55

To activate a license using the interactive web method, do 
the following:

1. Start up the license manager.

2. Select Using the interactive web method as your method of 
activation. 

The following License Activation Wizard window appears:
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Activating a License Using the Web
3. Click Save the instructions into a file button. 

The instructions shown in the License Activation Wizard window 
are saved to a file that you can print or refer to at a later date. The 
instructions provide the Node Lock Type and the Node Lock that 
you enter when activating from the web.
You can also display the Node ID information by selecting Display 
Node Lock under the Utilities menu in the License Manager 
window.

4. On a computer that has Internet Access, enter the web address 
www.dialogic.com/activation, which directs you to a secure 
server. The following screen appears.

5. Enter your original License Key (this can be found on your 
License certificate) and click Submit. The following screen 
appears.
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Activating a License Using the Web
6. Click Generate Licenses. The following screen appears.
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Activating a License Using the Web
7. Select the Product you are activating. Select the Node ID Type 
and enter the Node ID. If you are using License Manager version 
2.0 or greater, select Node ID type VID. If you are using an earlier 
version than 2.0, select Node ID type COMPOSITE.

8. Click Generate License. 
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Activating a License Using the Web
9. Verify that the information on this screen is correct and click 
Confirm. The following screen appears.

10. Click Save to File to save the license file to your computer or click 
Email to have the License file emailed to you. The following screen 
appears.
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Activating a License Using the Web
11. Follow the instructions Installing Licenses on page 47 to install 
the license file. 
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Activating a License Using Email or Fax

When your system cannot support the previous options (for example, 
you have no Internet connections) you can activate your license by 
sending the information to Dialogic using email or fax.

Note: If you activate your license by email or fax, Dialogic will send 
you the license file in about one business day.

To activate a license by Email or Fax, do the following:

1. Start up the license manager.

2. Select Create a request for email or fax as your method of 
activation. 

3. Click Next. 
The following License Activation Wizard License Key dialog box 
appears:
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Select the Add button to enter all purchased License Keys 
one at a time.  
You can enter more than one License Key. You must enter at 
least one License Key to proceed, otherwise an Error dialog 
box appears.

The Please enter License Key dialog box appears (this License 
Key can be found on your License certificate, for example 
BRKT111-1234567):

4. Click Next and fill in the registration information as requested. 

5. Click Next.
The Email/Fax Request dialog box appears:

6. Click the Save the request into a file button to save all information 
entered into the Product Registration dialog boxes to a text file.

7. Email the saved file to activation@dialogic.com as an attachment, 
or fax this information to +1 781-433-2350 at the Dialogic License 
Activation Center for processing.

When you receive the license file from Dialogic, go to Installing 
Licenses on page 47 to install it in the correct location.
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Installing Licenses

When you receive a license file from the Dialogic License Activation 
Center (via email or saved from the site) use the License Manager 
application to install the attached license. 

If you receive the license file via email, the licensing information is 
sent to you in the body of the e-mail. You must create a file with a 
.LIC extension and copy the licensing information from the e-mail 
into that file. If you save the license file from the site, you save the 
file to a temporary site as indicated in step 1 below.

Note: If you use the automatic activation method, you do not need to 
install licenses. Your activation process is finished.

Follow the steps below to install a license:

1. Save the license file to a temporary location (for example, 
\brooktrout\boston\bin) on your hard drive. 

2. Start the License Manager by selecting the following:

Start → Program Files → Brooktrout → Brooktrout License 
Manager

3. The License Manager window appears. 
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4. Select Install License from the License menu. The following screen 
appears:

5. Browse to the location of the license file. 

6. Highlight the filename, then click Open to activate your product.

Note: When the application is installed, an environment variable is 
created called: BRKTD_LICENSE_FILE, which refers to a file 
directory used by the License Manager to store license files. 
For more information on environment variables, please refer 
to your operating system documentation.
April 2009 48



Logging Information
Logging Information

The License Manager always provides logging information when 
errors occur. The application logs all messages preceding the error 
condition as well as messages following the error event. This log is 
helpful to Dialogic Technical Services and Support when solving 
problems.

In addition, you can execute the License Manager with the /d or --
debug option. For example, run brktlicmgr /d in a command 
window. Then the application logs all the information about the 
installed licenses.

This text log file, called brktlicmgr.log, is stored in the application 
directory. 
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Managing License Files

The section contains the following instructions to manage the license 
files:

Naming License Files on page 51

Backing Up Licenses on page 51

Removing Licenses on page 51

Replacing Lost or Unrecoverable Licenses on page 52 

Re-Installing Your Product on page 52

Restoring License Files on page 53

Re-Hosting License Files on page 55

You can find license files (*.lic) in the path specified by the following 
environment variable:

BRKTD_LICENSE_FILE

The License Manager typically stores the files in this path:

C:\Program Files\Common Files\Brooktrout\

If you remove Ethernet network cards from your system, the license files 
become invalid if the card has a license file node locked to it. To activate 
the products, re-host the licenses (see Re-Hosting License Files on 
page 55).

Note: If the ISV took the necessary steps, the license files are not 
removed when you remove the application using the uninstall 
option. Unless you manually remove the files, they are always 
located in the following directory:

C:\ProgramFiles\Common Files\Brooktrout 
The environment variable BRKTD_LICENSE_FILE is removed 
when the Brooktrout SDK is uninstalled. 
 
Do not copy other files into this directory. Doing so could 
result in the Configuration Tool reporting errors. 
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Naming License Files

All license files end with the .lic extension. One file can contain one 
or more licenses. The license filename is usually in either form: 

dd-mmm-yyyy.lic 
dd-mmm-yyyy-x.lic (next available number)

However, the license filename can be any filename with a .lic 
extension.

Backing Up Licenses 

To back up licenses, copy all *.lic files from the directory into a safe 
location. Copying the license files back to the same directory restores 
the licenses.

Typical directory: 
c:\Program Files\Common Files\Brooktrout\

The path to the directory containing the license files can be found in 
the environment variable: 
BRKTD_LICENSE_FILE

Removing Licenses 

The License Manager does not provide the means to remove licenses; 
you need to remove the license manually. 

To remove a license manually, you need to know the license serial 
number (the serial number for each license displays on the main 
screen of the License Manager).

1. Search the following directory for .lic files, typically:

c:\Program Files\Common Files\Brooktrout\
If you cannot locate the .lic files in this directory, the path can be 
found in the environment variable:
BRKTD_LICENSE_FILE

2. Open each .lic file until you find the file that includes the one with 
the serial number in it. 

3. Delete the license containing that serial number.

If there are no more entries in the .lic file, you can delete the file.
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Replacing Lost or Unrecoverable Licenses

When a license is lost or not recoverable, get a new copy by going 
through the web activation process again. See Activating a License 
Using the Web on page 39. 

Re-Installing Your Product

If you want to simply re-install your product on the same computer 
system after upgrading or replacing your hard disk or any other 
upgrade that maintains your network card’s MAC address, you can 
use the same license file without having to re-activate your product.
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Restoring License Files

If anything ever happens to your computer that leads to corruption of 
your software and the License File, retrieving another copy is a 
simple procedure. To retrieve another copy of your License File,

1. Visit the Dialogic activation website at: 
www.dialogic.com/activation 
 
The following screen appears.

2. Enter your original License Key (this can be found on your 
License certificate) and click Submit. The following screen 
appears.
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3. Click View Licenses. The following screen appears.

4. In the Select Product window, select your product and then select 
the appropriate Node ID. Click View. The following screen appears. 

5. Click Save to File or click Email to have the License file emailed to 
you. Follow the instructions Installing Licenses on page 47 to use 
the License Manager application to install the license file. 
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Re-Hosting License Files

To allow you to upgrade your computer to a new system or recover 
from a network card failure, Dialogic allows you to “re-host” your 
licensed software from one computer system to another. This process 
involves returning your current license and receiving another one.

The activation center web site allows you to automatically re-host 
your licensed software one time without technical support. For 
subsequent re-hosts you will need to contact Dialogic Technical 
Services and Support.

Follow the steps below:

1. Visit the Dialogic activation website at: 
www.dialogic.com/activation 
 
The following screen appears.

2. Enter your original License Key (this can be found on your 
License certificate) and click Submit. The following screen 
appears
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3. Click Re-host Licenses. The following screen appears.

4. Select your product and click Return to return the license to 
Dialogic. The following screen appears.
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5. Verify that the information on this screen is correct and click 
Confirm. The following screen appears.
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6. In the Select Product box click the product for which you are re-
hosting. Select the Node ID Type and enter the Node ID. The 
Node ID Type must be VID (Vendor Defined Node ID) if you are 
using License Manager Version 2.0 or later. (Go to the Help 
Menu, and click About ... if you are not sure of your version of 
License Manager.)
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7. Click Generate License. The following screen appears.

8. Click Confirm. The following license appears. 
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9. Click Save to File to save the license file to your computer or click 
Email to have the License file emailed to you. The following screen 
appears.

10. Follow the instructions Installing Licenses on page 47 to use the 
License Manager application to install the license file on the 
appropriate computer.
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3 - Configuring Dialogic® Brooktrout®
SR140 Software

This chapter describes how to configure the Brooktrout software for 
your Brooktrout virtual modules.

Dialogic provides the following method for configuring the virtual 
module:

Configuring in Wizard Mode on page 62 (adequate for most 
configurations)

.Advanced Mode on page 88.

However, this method has not been adapted by every ISV software 
package. Instead, when this method is not used by your ISV 
application, please skip this chapter and consult the documentation 
that comes with your ISV application for the configuration of the 
SR140 Fax Software.
April 2009 61



Configuring in Wizard Mode
Configuring in Wizard Mode

This section describes how to use the Wizard Mode to configure 
Dialogic® Brooktrout® Fax Software. You can use Wizard Mode to 
get most typical systems up and running with minimal effort.

In Wizard Mode, after you answer the basic questions, the 
Configuration Tool does the following.

Automatically creates the necessary configuration file

Installs and starts the drivers, if required

Starts the Boston Host Service

Wizard Mode requires that all the modules be of the same kind. All 
modules are configured identically, that is, the modifications to the 
configuration apply uniformly to all the modules. 

You can use Wizard Mode in a homogeneous configuration where:

all the boards are of an identical type

or 

the system contains only SR140 virtual boards.  

In a non-homogeneous configuration, the Configuration Tool will 
automatically start in Advanced Mode.

To use Wizard Mode:

1. Start the Configuration Tool if it has not already been started by 
the Plug-and-Play installation procedure. See Running the 
Dialogic® Brooktrout® Configuration Tool on page 93.
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2. The Welcome window appears.

3. When the Welcome window appears, you can choose to click the 
Advanced Mode button or the Next button.

Advanced Mode
If you select Advanced Mode, the Configuration Tool exits 
Wizard Mode and starts in Advanced Mode (see Advanced 
Mode on page 88).

Next
If you click the Next button, Wizard Mode continues and 
creates the necessary configuration file after you answer the 
basic questions.
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4. The System Report appears on the right-hand panel, then click 
Next. 

This example shows the information for a T1 board.

5. Click Next and the following screen appears if the system detects 
a board that supports both IP and PSTN.

6. If you want to configure IP call control, select Internet Protocol (IP) 
Network and refer to Configuring IP Call Control on page 66. 
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If you want to configure PSTN call control, select Public Switched 
Telephone Network (PSTN) and refer to Configuring PSTN on 
page 84 
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Configuring IP Call Control

Follow the steps below to configure IP Call Control:

1. The following screen appears either after you select Internet 
Protocol (IP) Network or if your system supports only IP Call 
Control.

2. Select SIP or H.323. Click Next and the following screen appears 
if your system is board-based. If your system is software based the 
following step is skipped.
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3. Configure the Ethernet Port for each board detected. Click Next 
and the following screen appears if there are multiple IP 
Interfaces detected in the system.

4. Specify which network interface to use for IP calls. 
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5. Refer to one of the sections below depending on which protocol 
you want to configure:

Configuring SIP Call Control Protocol on page 68

Configuring H.323 Call Control on page 76

Configuring SIP Call Control Protocol

The section contains the following procedures. 

Configuring Direct Routing by the Application on page 68

Configuring SIP Call Control with Gateway or IP-PBX on page 69

Configuring SIP Call Control with a Proxy Server on page 70

Configuring Direct Routing by the Application

If you chose to configure the SIP Call Control protocol the following 
screen appears:

Follow the steps below to configure Direct Routing by the 
Application. 

1. Select Direct routing by the Application. 
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2. There is no routing configuration required because the 
application routes the call. Click Next and refer to Configuring 
SIP Fax Setup on page 75

Configuring SIP Call Control with Gateway or IP-PBX

If you chose to configure the SIP Call Control, the following screen 
appears.

Follow the steps below to configure SIP Call Control with a 
Gateway or IP-PBX.

1. Select Automatic routing to a Gateway or IP-PBX. Click Next and 
the following screen appears.
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2. Enter the Primary Gateway. Click Next and refer to Configuring 
the SIP Registrar on page 73 

Configuring SIP Call Control with a Proxy Server

If you chose to configure the SIP Call Control the following screen 
appears.
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Follow the steps below to configure SIP Call Control with a SIP 
Proxy Server

1. Select Dynamic routing by a Proxy Server. Click Next and the 
following screen appears.
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2. Enter the IP address of the Primary Proxy Server and select Yes  
if there are additional proxy servers to configure. Click Next and 
the following screen appears.

3. Enter the IP address of any additional proxy servers. Click Next 
and continue to the next step Configuring the SIP Registrar on 
page 73
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Configuring the SIP Registrar

When the screen below appears, you can configure a SIP 
Registrar. 

1. From the screen above, select Yes to set up a SIP registrar. Click 
Next and the following screen appears.
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2. Complete the information on this screen and click Next. The 
following screen appears.

3. Select Yes to configure additional registrar servers. The following 
screen appears.

4. Enter the IP addresses of the additional registrar servers. Click 
Next and the following screen appears. Refer to Configuring SIP 
Fax Setup on page 75
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Configuring SIP Fax Setup 

When the screen below appears, you can configure Fax.

1. Configure the fax transmission and the configuration is complete. 
Click Next and refer to Applying Changes after the Configuration 
is Complete on page 82. 
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Configuring H.323 Call Control 

You can configure H.323 Call Control three ways:  

Configuring H.323 Direct Routing by the Application on page 76

Configuring H323 Call Control with a Gateway on page 77

Configuring H.323 Call Control with a Gatekeeper on page 78

Configuring H.323 Direct Routing by the Application

If you chose to configure the H.323 Call Control, protocol the 
following screen appears. 

Follow the steps below to configure Direct Routing by the 
Application. 

1. Select Direct routing by the Application.

2. This is no routing configuration required because the application 
routes the call. Click Next and refer to Configuring H.323 Fax 
Setup on page 80
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Configuring H323 Call Control with a Gateway

If you chose to configure the H.323 Call Control protocol the 
following screen appears.

Follow the steps below to configure H.323 Call Control with a 
Gateway or IP-PBX.

1. Select Automatic Routing to a Gateway or IP-PBX. Click Next and 
the following screen appears.
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2. Enter the Primary Gateway IP address. Click Next and refer to 
Configuring H.323 Fax Setup on page 80.

Configuring H.323 Call Control with a Gatekeeper

If you chose to configure the H.323 Call Control protocol the 
following screen appears.
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Follow the steps below to configure H.323 Call Control with a 
Gatekeeper: 

1. Select Dynamic Routing by a Gatekeeper. Click Next and the 
following screen appears.

2. Enter the IP Address of the Primary Gatekeeper. Click Next and 
the following screen appears.
April 2009 79



Configuring in Wizard Mode
3. Select Yes to specify additional gatekeepers. Click Next and the 
following screen appears.

4. Enter the IP addresses of the additional gatekeepers. Click Next 
and refer to Configuring H.323 Fax Setup on page 80

Configuring H.323 Fax Setup

When the screen below appears, you can configure Fax. 
April 2009 80



Configuring in Wizard Mode
1. Configure the fax transmission and the configuration is complete. 
Click Next and refer to Applying Changes after the Configuration 
is Complete on page 82.
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Applying Changes after the Configuration is 
Complete

Follow the steps below to save apply the changes.

1. Click either Save and Exit, Help, Back, Apply, or Cancel.

Save and Exit
Save the configuration and Exit without initializing the 
modules.

Help 
Displays help for the Configuration Tool.

Back
Displays previous page.

Apply 
Saves the configuration and initializes the modules.

Cancel
Does not save the configuration and exits.
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2. Click Apply and the board is initialized and configured. The 
following screen appears. 
April 2009 83



Configuring in Wizard Mode
Configuring PSTN

Protocol Options

Dialogic recommends that you accept the defaults that are based on 
the modules the Configuration Tool identified in your system. In this 
example, the module uses the T1 ISDN protocol.

Note: In Wizard Mode all the ports of all the modules will be 
configured with the same port setting.
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3. Click the Show Details >> button.

 Note the details of the protocol chosen by the Configuration Tool.

Protocol Details

The protocol details appear in the panel below the Protocol Options. 
The options are dependent on the protocol chosen. 

This example displays the options for the T1 ISDN protocol. 

See the Configuration Files in Volume 6 of the Bfv API Reference 
Manual for more information about the protocol parameters. 

Note: In wizard mode all the ports of all the modules will be 
configured with the same port setting.

4. Click Next. 
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The following screen appears. 

5. Click either Save and Exit, Help, Back, Apply, or Cancel.

Save and Exit
Save the configuration and Exits without initializing the 
modules.

Help 
Displays help for the Configuration Tool.

Back
Displays previous page.

Apply 
Saves the configuration and initializes the modules.

Cancel
Does not save the configuration and exits.

6. The Finish window appears if you selected Apply.
April 2009 86



Configuring in Wizard Mode
7. Click Finish to complete the configuration.
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Advanced Mode

If you have different types of Dialogic® Brooktrout® modules in your 
system or you want to configure your identical modules differently, 
you must use Advanced Mode: 

When the Dialogic® Brooktrout® Configuration Tool detects that 
you have different modules, it starts in Advanced Mode. 

When you start the Configuration Tool in Wizard Mode, you can 
move to Advanced Mode immediately by clicking the Advanced 
Mode button.

The Advanced Settings parameters for all module types are 
presented in logical groups. The ordering of the groups is 
alphabetical. The ordering of parameters within a group is according 
to their relative importance.

Most parameters are hidden unless you click Show Advanced. 
Generally, a user does not need to change the advanced parameters. 
See Call Control Parameters on page 102.

Advanced Mode Window When you enter Advanced Mode, the Brooktrout Configuration Mode - 
Advanced Mode window appears.
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Navigating in Advanced 
Mode

To navigate in Advanced Mode use the menus and buttons on 
the tool bar and the tree view on the left panel of the dialog 
boxes. 

Select one of the following to view the accompanying right panel 
information: 

Select Brooktrout to display the welcome window, if you are 
not already there. 
Select Driver Parameters to display the Driver Parameters 
dialog box. 
For sample values, see Driver Parameters (All boards) on 
page 99.

Select BTCall Parameters to display the BTCall Parameters 
dialog box. 
For sample values, see BTCall Parameters (All boards) on 
page 100.

Select Call Control Parameters to display the Call Control 
Parameters dialog box. 
For sample values, see Call Control Parameters on page 102.

Select IP Call Control Parameters to display the IP Call Control 
Parameters dialog box. 
For sample values, see IP Call Control Modules on page 108.

Advanced Mode Menus The following menu items are available in the Advanced Mode 
window:

The File menu allows you to exit from the Configuration Tool.

The View menu allows you to choose the previous or next 
window.

The Options menu allows you to: 

Choose to apply and/or save the configuration.

Reconfigure the driver.

Launch the Dialogic® Brooktrout® License Manager.

Configure the IP Stack.

Edit Trace Connections Settings.

Set your preferences for the locations of the btcall.cfg and 
callctrl.cfg configuration files, the firmware, and log files.
The Preferences dialog box is shown in Getting Help From the 
Dialogic® Brooktrout® Configuration Tool on page 95.

Display the toolbar.
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The Help menu provides the following options:

Access to the Configuration Tool Help Index Contents tree.

Access to the Configuration Tool Help Index tab where you 
can navigate through the Help index entries.
Search tab where you can look for any text entry.

About provides version and copyright information for the 
Configuration Tool.

Advanced Mode Buttons The Advanced Mode window contains these buttons:

Select the Home button to go to the welcome window if you are 
not already there.

The Next and Back buttons take you to the next or previous 
pages, respectively.

The Save button saves your configuration.

The Apply button installs, starts or stops the Boston Host 
Service. It also saves your configuration to the appropriate 
configuration file. 

If driver parameters were modified, it dynamically reconfigures 
the drivers on a PnP operating system. 

The License button launches the Dialogic® Brooktrout® License 
Manager (bkrtlicmgr.exe).

The Help button displays help for the Configuration Tool in any 
mode.
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Driver Parameters (All boards)

Click on Driver Parameters (All Boards) in the left panel to display the 
Driver Parameters in the right panel. 

See Installing and Configuring the Driver using a Command (cmd) 
Prompt on page 112. 
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Reconfigure Drivers Right-click on Driver Parameters (All Boards) in the left panel to 
reconfigure the driver. 

This option dynamically updates the driver parameters by calling 
reconfig on a PnP system.
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Running the Dialogic® Brooktrout® Configuration 
Tool

When you start the Configuration Tool for the first time, you may get 
a Preferences Dialog box pop up. Only change the locations for the 
various files used by the Configuration Tool when requested by your 
application. 

When the Configuration Tool detects an IP-enabled device, it 
displays the Configure IP Stack dialog box. Check with your network 
administrator whether you will use the SIP or H.323 IP call control. 
If you don't know yet, select “Both (SIP and H323)” so that both 
protocol stacks get installed. 

None - IP stack not installed

SIP - SIP stack installed (default)
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H.323 - H.323 stack installed

Both (SIP and H.323) - Both SIP and H.323 stacks installed.
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Getting Help From the Dialogic® Brooktrout® Configuration 
Tool

The Dialogic® Brooktrout® Configuration Tool provides context 
sensitive online help for parameters. The Help displays the purpose 
and description of the parameter including the default value and 
range, if applicable. 

Hold the cursor over the parameter input area to see a brief 
parameter description.
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Right-click the parameter drop-down box to get a more complete 
definition for Configuration Tool parameters. 

The What’s This? popup menu appears:

Left-click the What’s This? popup menu for a definition like the 
following. You can resize this text box, if necessary.

Advanced Mode Menus The following menu items are available in the Advanced Mode 
window:

The File menu allows you to exit from the configuration tool.

The View menu allows you to choose the previous or next 
window.

The Options menu allows you to:

Choose to apply and/or save the configuration.
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Reconfigure the driver.

Launch the Brooktrout License Manager.

Configure the IP Stack.

Set your preferences for the locations of the btcall.cfg and 
callctrl.cfg configuration files, the firmware, and log files.
The Preferences dialog box is shown in Getting Help From the 
Dialogic® Brooktrout® Configuration Tool on page 95.

Display the toolbar.
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The Help menu provides the following options:

Access to the Configuration Tool Help Index Contents tree.

Access to the Configuration Tool Help Index tab where you 
can navigate through the Help index entries.
Search tab where you can look for any text entry.

About provides version and copyright information for the 
Brooktrout Configuration Tool.

Advanced Mode Buttons The Advanced Mode window contains these buttons:

Home button to go to the welcome window if you are not already 
there.

Next and Back buttons take you to the next or previous pages, 
respectively.

Save button saves your configuration.

Apply button installs, starts or stops the Boston Host Service. It 
also saves your configuration to the appropriate configuration 
file.

If you modified driver parameters, it:

Dynamically reconfigures the drivers on a Plug and Play 
(PnP) operating system.
Installs the Boston Host Service if the service is not 
installed.
Stops the Boston Host Service if the service is not running.

Starts the Boston Host Service.

License button launches the License Manager (bkrtlicmgr.exe).

Help button displays help for the Configuration Tool in any 
mode.

Reconfigure Drivers Right-click on Driver Parameters (All Boards) in the left panel to 
reconfigure the driver.

This option dynamically updates the driver parameters by:

Calling reconfig on a PnP system.
April 2009 98



Running the Dialogic® Brooktrout® Configuration Tool
April 2009 99



Running the Dialogic® Brooktrout® Configuration Tool
BTCall Parameters (All boards)

Click on BTCall Parameters (All Boards) in the left panel to display 
the BTCall Parameters in the right panel. No BTCall Parameters 
need to be changed, except when debugging is required. The country 
parameter is not used for the SR140.

Debugging Options

Debugging Disabled When debugging is disabled all the BTCall Parameters 
debugging-related parameters are grayed out.
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Debugging Enabled The Bfv API Debug file is the main Brooktrout log, capturing debug 
information about faxing.

When you enable Bfv API Debugging, you need to specify a file name 
to write the Brooktrout debug information to. You can even specify a 
second file name, and set the size of the first file so that a second file 
is created when the first file has reached the specified size. 

When you enable Bfv API Debugging, and you enable “Trace Bfv API 
Function Calls”, you will get the following info added to the log file:

Trace the entry to each Bfv API function call.

List the parameter passed into a function.

Trace the exit from each Bfv API function call.

See the right panel for specific debug parameter information.

For more information about the Show Advanced >> button, see 
Advanced Settings on page 124.

Note: Most users never need to alter the Advanced Settings 
parameter values.
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Call Control Parameters

Click Call Control Parameters in the left panel to display the Report 
tab in the right panel.

Reporting and Debugging (Tracing)

Report Panel The Report tab displays the Call Control Parameters port 
configuration information.
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Tracing Panel The Tracing tab displays the Call Control Tracing debug parameters. 
Turning the parameters on will create a call control trace, sometimes 
called ECC-trace, which captures all call related debug information, 
similar to call setup and call tear down of the SIP or H.323 call.

Note: Do not change any of these parameters until you have 
consulted with Dialogic Technical Services and Support. See 
Getting Technical Support on page 22.

Module Tab Settings

Click the module name in the left panel tree view to modify 
information about each module.

SR140 modules features and number of channels depends on the 
license installed on the user system. You can obtain, install, and 
update the license using the License Manager utility. When you 
have installed multiple licenses, you will still typically see only one 
SR140 module. So, licenses get added up to look like a single module.

Note: A special demo license is available in either a single- or 
two-channel configuration that will run for a 30 day period. 
Contact your Dialogic sales representative to obtain this 
license.
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The Apply button on the toolbar starts the Boston Host Service to 
initialize the module. See Advanced Mode Buttons on page 98.

The License button on the toolbar launches the License Manager 
(bkrtlicmgr.exe).

General Information Tab  
for SR140

Use this feature to query the SR140 Fax Software licensing. 

Virtual Module - Not 
Available

An SR140 module displays in the General Information tab even when 
there is no valid license installed.
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After Use License Manager utility to install the license displays, you 
can click the icon to invoke the License Manager utility 
(brktlicmgr.exe). 

Parameters Tab for  
SR140

The Parameters tab displays the call control module type, Media IP 
Interface and IP port number information. You have to choose the IP 
call control type and you have to set the IP Interface.
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IP call control module

The options are SIP or H.323 as call control protocol for your IP 
calls. Choose the IP option to associate this Call Control Type 
with the Brooktrout virtual module. Please check with your IP 
provider. 

Media IP Interface

Specifies the identity of the device on the PC with the IP interface 
that the virtual module can use for sending Fax Over IP (T.38) 
messages and Voice Over IP (RTP G.711) packets. Set the value 
of this parameter to the name of any device in the PC with an IP 
interface. Lists the network cards in the fax server and their IP 
addresses - select the network card you want to use for your FOIP 
traffic and give this network card a static IP address. Contact 
your network administrator to assign a static IP address to this 
Ethernet port since DHCP- dynamic host configuration protocol 
is currently not supported by Dialogic. If DHCP is used on the 
interface it can work, but only when the IP address does not 
change while the SR140 virtual module is running. If you do not 
provide a value (blank string), the virtual module chooses the 
first interface in the PC to send its messages. The format for the 
value provided in this parameter is: The name of the IP device 
(Global Unique IDentifier (GUID)) followed by a colon (:) 
character followed by the index number of the device's IP address, 
For example: {4D36E96E-E325-11CE-BFC1-08002BE10318}:0  
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Note: Currently, the Bfv API only supports the GUID 
information on Windows® operating systems. 

Value Type: character string (up to 256 characters) 
Default: <blank> (the virtual module uses the first 

interface in the PC for sending IP messages)

Lowest IP Port Number

Specifies the lowest IP port number that the module can use for 
media transmissions. Set this value to a value 1000 below the 
value specified for the media_port_max parameter. Valid values 
are:
Range: 1024 - 64535 
Value Type: decimal
Default: 56000 (sets this value as the lowest port number)

Highest IP Port Number

Specifies the highest IP port number that the module can use. Set 
this value to a value 1000 above the value specified for the 
media_port_min parameter. Valid values are:
Range: 2024 - 65535 
Value type: decimal
Default: 57000 (sets this value as the highest port number)
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IP Call Control Modules

Click IP Call Control Modules on the left panel to display 
information about any IP-enabled modules:

IP Call Control Modules 
Details

Both SIP and H.323 are supported for the call control over IP.

General Information Tab  
for SIP Stack

The General Information tab contains information about the library 
path, stack name, vendor name, and version number. 
April 2009 108



Running the Dialogic® Brooktrout® Configuration Tool
General Information Tab  
for H.323 Stack 

When you select an H.323 stack to configure, the General Information 
tab displays, as shown in the following example:

IP Parameters Tab for  
SIP Stack

The SIP IP Parameters tab allows you to set values for the following 
parameters. Most of these parameters do not need to be set; the 
defaults will work, but in practice, just like you configure the ID of a 
fax machine, you should set From value and Phone Number. 
However, if you have multiple NIC cards in your system, and you do 
not want to use the first NIC card for the SIP traffic, you need to 
specify the static (fixed) IP address of the NIC card you want to use 
for the SIP messages in the Contact name field. This IP address will 
typically be the same as the IP address selected under “Media IP 
Interface” in the Parameters tab under the SR140 module, which 
selects the NIC card for the FOIP traffic. If the local network has a 
SIP proxy server and a SIP registration server, please contact your 
network administrator to set the Primary Proxy Server and Primary 
Registrar Server. If you do not have a SIP proxy/registration server, 
you have to set Primary Gateway when your application is not 
setting this value already. 
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Contact Name

Set this parameter to the IP address of the network interface 
(NIC) in the machine that you want to use for the SIP messages. 
Here, you typically want to set the same IP address as the one 
selected under the Media IP Interface parameter in the  
IP Parameters tab under the SR140 module. When left blank, it 
defaults to the first network interface in the system.
When this parameter is set to its default value 
(sip_Contact=0.0.0.0), the SIP stack automatically attempts 
to find the IP address of the local host during initialization. If the 
host has not registered its host name, the SIP initialization 
process will fail and SIP calls will not be processed. To process 
SIP calls in this case, the value in the sip_Contact parameter 
must be specifically set to an IP address of one of the host network 
interface boards.
When set, this parameter must contain an IP address in the form:
xxx.xxx.xxx.xxx:PortNumber (port number is optional)
10.128.22.6:5060 (port number specified) 
10.128.22.6 (no port number specified)
Note: For the SIP protocol, the port defaults to 5060 if not 

specified.
Range: 0 – 255 for each dotted decimal position of the 

IP address.
1 – 65535 for the port number

Value Type: dotted decimal
Default: 0.0.0.0:0 (system uses the IP address of the 

local host and port 5060)

Primary Gateway

Indicates the IP address of a default gateway to use for outbound 
calls. If you only specify a phone number when making a SIP call 
and the application is not using a SIP proxy server, the Bfv API 
forwards the call to the gateway specified with this parameter. 
The Bfv API forwards the specified phone number to the gateway 
for routing purposes.
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When set, this field must contain an IP address in the form:
xxx.xxx.xxx.xxx:PortNumber (Port number is optional)
10.128.22.6:5060 (port number specified)
10.128.22.6 (no port number specified)
Note: For the SIP protocol, the port defaults to 5060 if not 

specified.
Range: 0 – 255 for each dotted decimal position of the 

IP address.
1 – 65535 for the port number

Value Type: dotted decimal
Default: 0.0.0.0:0 (no default gateway defined)
The Bfv API does not use this parameter if the configuration file 
specifies a sip_registration_server or sip_proxy_server.

Description URI

Indicates the value used for the u= line in the SIP SDP. The  
u= line identifies the SIP uniform resource identifier (URI) of the 
session description. Valid values are:
Range: 1 - 255 characters
Value Type: character string (up to 256 characters)
Default: <blank> (empty string)

Email Address

Indicates the value used for the e= line in the SIP SDP. The  
e= line identifies the email address of the person or entity 
responsible for the session. Valid values are:
Range: 1 - 255 characters
Value Type: character string (up to 256 characters)
Default: <blank> (empty string)

From Value

Indicates the value provided in the SIP header for the From field. 
The From field contains a display name and a SIP uniform 
resource identifier (URI) or SIPS (secure SIP) URI that identifies 
the originator of the session request. So, set the SIP address of 
the SR140 Fax Software here. Valid values are:
Range: 1 - 255 characters
Value Type: character string (up to 256 characters)
Default: Anonymous 

<sip:no_from_info@anonymous.invalid>"
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Maximum SIP sessions

Indicates the maximum number of concurrent session initiation 
protocol (SIP) call control sessions. Note: setting this to a value 
higher than the number of channels licensed for the SR140 
virtual module will not increase the number of simultaneous 
faxes that the SR140 can send/receive. Valid values are:
Range: 1 through 1000
Value Type: decimal
Default: 256

Phone Number

Indicates the value used for the p= line in the SIP SDP. The p= 
line identifies the phone number to associate with the session. 
Phone numbers use the conventional international format: the 
number preceded by a + (plus symbol), the country code and a 
space or hyphen character. For example:  
+1 408-370-0881 So, please set this to the externally published 
phone number for the SR140 virtual fax module. Valid values are:
Range: 1 - 255 characters
Value Type: character string (up to 256 characters)
Default: <blank> (empty string)

Primary Proxy Server

Additional Proxy Server #2

Additional Proxy Server #3

Additional Proxy Server #4

Indicates the address of the specified SIP proxy server. Define a 
maximum of 4 proxy servers. Valid values are:
Domain name Indicates the name or IP address of the proxy 
server.
Range: 1 - 4 proxy servers specifying any valid domain 

name (for example, www.my_sip_server.com or 
192.168.1.45)

Value Type: character string (up to 256 characters)
Default: <blank> (empty string indicating no proxy server 

defined)
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Primary Registrar Server 

Additional Registrar Server #3

Additional Registrar Server #4

Additional Registrar Server #4

Indicates the address of the specified SIP registration server. The 
user can define a maximum of 4 registration servers. Valid values 
are:
Domain name Indicates the name or IP address of the 

registration server (up to 256 characters).
Range: 1 - 4 registration servers specifying any valid 

domain name (for example, 
www.my_registration_server.com or 
192.168.1.45)

Value Type: character string (up to 256 characters)
Default: <blank> (empty string indicating no registration 

server defined)

Session Description

Indicates the value used for the i= line in the SIP SDP. The i= line 
provides a textual string that describes the session's purpose or 
provides information about the session. Valid values are:
Range: 1 - 255 characters
Value Type: character string (up to 256 characters)
Default: <blank> (empty string)

Session Name

Indicates the value used for the s= line in the SIP SDP. The s= 
line provides a textual string that gives a name to the session. 
Valid values are:
Range: 1 - 255 characters
Value Type: character string (up to 256 characters)
Default: no_session_name
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Username

Indicates the name inserted into the o= line in the SIP session 
description protocol (SDP). The o= line defines the owner or 
creator of the session and the session identifier. This value must 
not contain spaces. Valid values are: - (dash) = A dash or hyphen 
character indicates the absence of an owner name or session ID.
Range: 1 - 255 characters
Value Type: character string (up to 256 characters)
Default: - (dash or hyphen character)
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IP Parameters Tab for  
H.323 Stack

When you select an H.323 stack to configure, the IP Parameters tab 
allows you to set values for the following parameters (see example on 
page 120). Most of these parameters only need to be configured when 
you have a gatekeeper in your local network. However, if you have 
multiple NIC cards in your system, and you don't want to use the 
first NIC card for the H.323 traffic, you need to set the static (fixed) 
IP address of the NIC card you want to use for the H.323 messages 
in the h323_local_ip_address field. This IP address will typically be 
the same as the IP address selected under Media IP Interface in the 
IP Parameters tab under the SR140 module, which selects the NIC 
card for the FOIP traffic. If not set, it will take the IP address of the 
first Ethernet interface (NIC card) in the chassis. If you don't have 
an H.323 gatekeeper, you have to set h323_default_gateway when 
your application isn't setting this already.

Primary Gateway

Indicates the IP address of a default gateway to use for outbound 
calls. If you only specify a phone number when making an H.323 
call and the application is not using an H.323 gatekeeper, the Bfv 
API forwards the call to the gateway specified with this 
parameter. The Bfv API forwards the specified phone number to 
the gateway for routing purposes. When set, this field must 
contain an IP address in the form: xxx.xxx.xxx.xxx:PortNumber 
(Port number is optional)
Examples
10.128.22.6:1720 (port number specified)
10.128.22.6 (no port number specified
Note: For the H.323 protocol, the port defaults to 1720 if not 

specified.
Range: 0 – 255 for each dotted decimal position of the 

IP address.
1 – 65535 for the port number

Value Type: dotted decimal
Default: 0.0.0.0:0 
Note: The Bfv API does not use this parameter if the 

configuration file specifies a value of 1 for the h323_register 
parameter.
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E.164 Aliases

Specifies the E.164 alias of the H.323 terminal. This alias is used 
during gatekeeper registration and call establishment. It 
identifies the phone number of the H.323 terminal.
You can specify multiple aliases, each starting on a new line 
using the same parameter name. For example:
h323_e164alias 123456
h323_e164alias 4084839648
h323_e164alias 5102987468
h323_e164alias 9627842899

When you specify multiple values, the system registers every 
value with the gatekeeper.
Valid values are:
Range: 1 - 128 characters (inclusive)
Value Type: character string restricted to numbers 0 through 

9 and the star (*) and pound (#) symbols
Default: <blank>

Gatekeeper ID

Specifies the ID of the H.323 gatekeeper that the H.323 terminal 
will attempt to find during the gatekeeper discovery routine. If 
you do not set this parameter, the H.323 terminal will attempt to 
register with the first gatekeeper it finds. Valid values are:
<blank> = Uses the first gatekeeper the H.323 terminal locates.
Value Type: Unicode character string (up to 256 characters)
Default: <blank>
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Primary Gatekeeper

Fallback Gatekeeper #2 

Fallback Gatekeeper #3 

Fallback Gatekeeper #4 

Fallback Gatekeeper #5 

Fallback Gatekeeper #6

Specifies the IP address of up to six H.323 gatekeepers that will 
receive the registration request from the H.323 terminal. If you 
leave this parameter blank, the H.323 terminal will perform a 
multicast gatekeeper discovery routine to find the gatekeeper 
using port number 1719. Valid values are:
xxx.xxx.xxx.xxx Configures the system to use the specified 

H.323 gatekeeper. Set the gatekeeper IP 
address in the form:
xxx.xxx.xxx.xxx:PortNumber

0.0.0.0:0 Configures the system to use a multicast 
process to discover the H.323 gatekeeper 
using port number 1719.

Range: 0 – 255 for each dotted decimal position of 
the IP address.
1 – 65535 for the port number

Value Type: dotted decimal
Default: 0.0.0.0:0 (uses multicast discovery 

process and port number 1719)

Gatekeeper Time to Live

Specifies the number of seconds to allow between registration 
request messages sent from the H.323 terminal to the 
gatekeeper. After reaching this limit, the H.323 terminal 
generates another registration request to the gatekeeper because 
the previous request is now considered invalid. Valid values are:
Unit: second
Range: 0 - 32,000,000 (0 means that gatekeeper 

registrations do not expire; 32,000,000 seconds 
equals one calendar year)

Value Type: integer
Default: 0
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Local H.323 Terminal ID

Specifies the H.323 ID of the H.323 terminal. This alias is used 
during gatekeeper registration and call establishment. It 
identifies the name of the H.323 terminal. You can specify 
multiple aliases, each starting on a new line using the same 
parameter name. For example:
h323_h323IDalias andrew
h323_h323IDalias bob
h323_h323IDalias charles
h323_h323IDalias david

When you specify multiple values, the system registers every 
value with the gatekeeper. Valid values are:
Range: Up to 256 characters
Value Type: Unicode character string
Default: <blank>

Local IP Address

Specifies the transport address of the H.323 terminal. The 
transport address can be an IP address or a combination of the IP 
address and the port number that the H.323 call control stack 
uses. If you do not provide an address, the system uses the IP 
address of the first Ethernet interface (NIC) in the system and 
port number 1720. Here, you typically want to set the same IP 
address as the one selected under the Media IP Interface 
parameter in the IP Parameters tab under the SR140 module. 
Valid values are:
xxx.xxx.xxx.xxx Configures the system to use the specified 

IP address for H.323 calls. Set the 
transport address in the form:
xxx.xxx.xxx.xxx:PortNumber

0.0.0.0:0 Configures the system to use the address 
of the first Ethernet module and port 
number 1720.

Range: 0 – 255 for each dotted decimal position of 
the IP address.
1 – 65535 for the port number

Value Type: dotted decimal
Default: 0.0.0.0:0 (uses first Ethernet module 

and port number 1720)
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Name of Manufacturer

Specifies a string naming the H.323 terminal’s manufacturer.
Range: Up to 256 characters
Value Type: Unicode character string
Default: "Dialogic Corporation"

Manufacturer Code

Specifies a code that identifies the manufacturer of the H.323 
terminal making the call.

Range: 0 – 255
Value Type: decimal
Default: 48
Note: 48 is the H.323 manufacturer code for Dialogic 
Corporation.

Maximum H323 Sessions

Indicates the maximum number of concurrent H.323 calls that 
the host module can support at one time. Set this value to a 
number that at least doubles the number of channels in the 
system because the system can be tearing down a call while 
processing the next call. Setting this to a higher value will not 
increase the number of simultaneous fax calls that have been 
licensed. Valid values are:
Range: 1 through 65535 (inclusive)
Value Type: decimal
Default: 256

Register with Gatekeeper

Specifies an integer value that determines whether to register 
with an H.323 gatekeeper. Valid values are:
0 = Does not register with an H.323 gatekeeper.
1 = Registers with an H.323 gatekeeper.
Value type: integer
Default: 0
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Support Alternate Gatekeepers

Specifies whether to support alternate gatekeepers. The 
gatekeeper receiving the registration request from the H.323 
terminal must also support alternate gatekeepers.
When the H.323 terminal sends a registration request to its 
primary gatekeeper, the primary gatekeeper will send the H.323 
terminal a list of alternate gatekeepers that it knows about. If, for 
some reason, the H.323 terminal can no longer communicate with 
its primary gatekeeper, it will go through the list of alternate 
gatekeepers and attempt to register with them.
When alternate gatekeepers are not supported and the H.323 
terminal can no longer communicate with its primary 
gatekeeper, it will go through the multicast gatekeeper discovery 
routine to find an available gatekeeper. Valid values are:
0 = Does not support alternate gatekeepers.
1 = Supports alternate gatekeepers when necessary.
Value type: integer
Default: 0

T.35 Country Code

Specifies a code identifying the international country that 
manufactured the H.323 terminal making the call. The code 
allows other H.323 terminals to know the origin of the H.323 
terminal. The ITU-T Recommendation T35 Annex A lists the 
country codes used for H.323 Non-Standard Facilities (NSF).
Range: 0 - 255
Value type: decimal
Default: 181
April 2009 120



Running the Dialogic® Brooktrout® Configuration Tool
T.35 Country Code Modifier

This parameter specifies a modifier for the country code of the 
vendor’s H.323 terminal making the call. If the T.35 country code 
is defined as hexadecimal FF, this extension value defines a two-
byte manufacturer country code.
0 = Does not support alternate gatekeepers.
1 = Supports alternate gatekeepers when necessary.
Value type: integer
Default: 0
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T.38 Parameters Tab for  
SIP Stack

The T.38 Parameters tab for a SIP stack allows you to set values for 
the following parameters. These parameters should work without 
being modified.

T.38 Parameters for H.323 
Stack

The T.38 Parameters tab for an H.323 stack allows you to set values 
for the following parameters. These parameters should work without 
being modified.
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RTP Parameters for SIP 
Stack

In the current release you cannot modify the values on the RTP 
Parameters tab.

RTP Parameters for H.323 
Stack

In the current release, you cannot modify the values on the RTP 
Parameters tab.
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Advanced Settings

Show Advanced Button When a parameter panel (for example: Driver Parameters, BTCall 
Parameters, Call Control Parameters) has advanced settings, the  
Show Advanced >> button appears on the bottom right of the right 
panel.
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Hide Advanced Button When you click Show Advanced, the Advanced Settings portion of the 
panel appears, and the Hide Advanced <<  button is displayed.

There can be more than one panel of parameter information for 
Advanced Settings.

Click the Hide Advanced << button to remove advanced parameters 
from the screen view.

Note: Most users never need to alter the Advanced Settings 
parameter values. If you know these settings are incorrect, 
please contact Dialogic Technical Services and Support for 
more information. See Getting Technical Support on page 22. 
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4 - Testing Dialogic® Brooktrout® SR140 
Software

This chapter explains how to use Dialogic® Brooktrout® Fax/Voice 
Diagnostic Test Tool for Windows® SDK version 6.1 to test your 
host-based SR140 virtual fax module over IP.

You must have installed the SR140 license file and therefore your SR140 
virtual module, before you continue here with configuration and testing. 
See Chapter , Activating Dialogic® Brooktrout® Products on page 27.

If you ISV’s application does not contain the Diagnostic Tes Tool, you 
can download a copy from the Dialogic Technical Services and 
Support website.  See Getting Technical Support on page 22 and 
download the the FDTool test tool that supports Boston driver 
version 6.1.

Also at the website you will find White Papers and Frequently Asked 
Questions besides Downloads. Dialogic recommends that you look on 
this site under the SR140 product and FOIP/T.38.

If you have already installed your LAN Fax application, you might want to 
first use the LAN Fax application to test your boards. If your application 
functions properly, then you do not need to use this test tool.
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You can test a maximum of 8 channels  simultaneously on the 
FDTool Diagnostic Tool in a Windows® operating system. See 
System Requirements on page 128."  The  System Requirements 
should be the same as in the SDK 6.1 Release Notes .

This chapter covers the following major topics:

System Requirements

Installing the Diagnostic Test Tool

Menus and Submenus

Generating Logs for Troubleshooting
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System Requirements 

The Fax/Voice Diagnostic Test Tool provides all the necessary 
software to send/receive a Fax over IP using the SR 140 virtual 
module.

You must have the following system requirements in order to use 
this tool to test your SR140 virtual module:

Windows® 2000 Professional, Service Pack 4 and Windows® 
Update 822831

Windows® 2000 Server, Service Pack 4 and Windows® Update 
822831

Windows® 2000 Advanced Server, Service Pack 4

Windows® XP Professional, Service Pack 2

Windows Server® 2003, Standard Edition, Service Pack 2

Windows Server® 2003 x64 Editions, Service Pack 2 
x86-64, Intel 64-Bit Xeon; Intel Pentium with EM64T

Windows Server® 2003, Enterprise Edition, 32-bit version, 
Service Pack 2

Windows Server® 2008

Windows® 2000 with Service Pack 4 requires Windows® Update 
822831 due to a Windows® issue with Service pack 4 that would cause 
the PnP driver to fail.
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Installing the Diagnostic Test Tool 

This section describes how to install and configure the diagnostic 
test tool and generate log files.

Note: You might have received the Brooktrout Hardware Test files as 
part of your fax application. If not, download a self-extracting zip file 
from the web by doing the following:

1. Go to the following Dialogic website 
http://www.dialogic.com/support/helpweb/brooktrout/).

2. Under Diagnostic and Testing Utilities selected Using the 
Dialogic Brooktrout Fax and Voice Diagnostic Tool for Windows.

3. Below FDtool for Drivers v6.1 - SDK 6.1, select Download.

4. Save the zip file to an empty directory and unzip it.

5. Extract the files to the current directory.

6. To launch the Diagnostic Test Tool, double-click the FDTool.exe 
icon. The following screen appears.
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Menus and Submenus 

The following table lists the menus and submenus of the Diagnostic 
Test Tool.

Table 1.   Diagnostic Test Tool Menus and Submenus

Menus Submenus

File Configure

Initialize

Exit

Tool Debug

VTTY Tracer

Reset Alarm Counters

Reset Configuration

Send Multiple TIFF

Reject Incoming Calls

Help Help

About fdtool
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7. From the fdtool-60\fdtool-6.0.0 screen click the Configure button.  
The following screen appears

8. Refer to the Running the Dialogic® Brooktrout® Configuration 
Tool on page 93 for instructions for using the Configuration Tool. 

9. Click OK and the following screen appears.
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10. Click Initialize. The following screen appears.
April 2009 133



Menus and Submenus
11. If there are more than eight SR140 channels, the information 
bubble above appears. If not, the following screen appears. 
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12. The folllowing screen indicates that you have entered a dial 
string. 

13. Click Dial to start the outgoing fax. 
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14. The following screen indicates that the fax is being sent from 
channel 1 to 2.. 
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15. The following screen displays the history information for channel 
1. 
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16. Click on the line for channel 2 to display the information for that 
channel. 

17. To enable logging, click Debug from the Tools menu.

18. Click Help About and the following screen appears  
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Generating Logs for Troubleshooting 

Various log files can be created for troubleshooting. All logs are 
created in the directory where the test tool is extracted.

Note: When Dialogic Technical Services and Support requests that 
you send log files to them, make sure you zip the log files prior 
to sending them.

Logging The Logging menu provides the following logging/saving functions:

Debug
VTTY Tracer

 Debug Submenu The most useful logging information for Dialogic Technical Services 
and Support generally is the Brooktrout debugging logs. The various 
possibilities for these files are as follows:

apidebug_unit_xx.log

apidbug_systemlog

These logs are written to continuously when you select the Brooktrout 
Debug Logging submenu.

The Debug logging feature should be turned on only under the 
direction of Dialogic Technical Services and Support.

VTTY Tracer Submenu You can select the VTTY Tracer from the Tools menu. 

1. Follow the instructions on the screen below. 
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2. Click OK and the VTTY Tracer utility appears. The select the 
setting indicated on the screen above.

Other Tools Options There are three other options under the Tools menu:

Reset Configuration - clears out the configuration files created 
with the Configuration tool. The Configuration tool would need 
to be run again by clicking on the Configuration button before 
the FDTool can be used again. It resets the whole configuration.

Send Multipage TIFF - Usuallly only a single-page TIFF file is 
used for sending faces with the FDTool. Selecting this option 
sends out a three pages TIFF file that alternates the fax 
resolution from fine to normal - bank to fine. 

Reject Incoming Calls - If this is selected, incoming calls will not 
be answered.  The utility would only be able to place outbound 
calls.
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5 - Dialogic® Brooktrout® SR140 
Specifications

Virtual Module Specifications

Fax

ITU T.30; ITU T.38; Group 3

V.17, V.23, V.29, V.27ter, V.21 modulation

Up to 14.4Kbps with auto fallback

Normal and fine resolution: 100x200, 200x200

MH, MR, MMR compression

Transparent image conversion

A4, A3 and B4 page sizes with scaling

A4 and B4 TIFF F file widths

Enhanced ASCII conversion support with headers

Error Correction Mode (ECM)

Line error detection/repeat good line

RTP

G.711 20 and 30ms packets
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Virtual Module Specifications
Voice

Prompt Playback

Prompt Record

Playback Gain Control

Inbound and Outbound Silence Suppression

Dynamic Range Control

High Frequency Preemphasis

Signal Generation/Detection

G.711 Single Frequency Tone Generation

G.711 DTMF Tone Generation

G.711 DTMF Tone Detection

Adaptive Call Progress Analysis
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Virtual Module Specifications
Call Control

H.323

SIP

Operating Systems

Windows® 2000 Server, Windows Server® 2003 
Windows® XP Professional.

Installation and Configuration

Windows® Graphical Configuration Tool

Models/Configurations

Application Programming Interface

Dialogic® Brooktrout® Fax and Voice (BFV)

Model Name Description

SR140-DEMO (1) 1 port T.38 HBF Demo license w/ 30 
day time limit

SR140-DEMO (2) 2 port T.38 HBF Demo license w/ 30 
day time limit

SR140-2F 2 port T.38 HBF

SR140-4F 4 port T.38 HBF

SR140-8F 8 port T.38 HBF

SR140-12F 12 port T.38 HBF

SR140-24F 24 port T.38 HBF

SR140-30F 30 port T.38 HBF

SR140-48F 48 port T.38 HBF

SR140-60F 60 port T.38 HBF

SR140-DEV 60 port T.38 HBF for Customer 
Development
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Index
Symbols
.cfg file 95, 102
.exe file 90, 98, 104
.lic file 51
.txt file 40

A
Activation Center unavailable 38
Activation Methods 33
Advanced Mode

Advanced Settings information 125
Configuration Tool 88
menu options 89
See also Configuration Tool

Advanced Settings, Advanced Mode 125
Automatic activation 35

B
Backing up licenses 51
Bfv API debugging 100
bkrtlicmgr.exe file 90, 98, 104
Boston Host Service

License Manager 104
brktlicmgr.exe file 30
Brooktrout License Activation Center

installing licenses 47
Brooktrout License Manager

activate 103
BTCall parameters 100

btcall.cfg file
choosing the location 95
configuration file 100

C
Call Control parameters

Report Panel Tab 102
callctrl.cfg file

configuration file 102
Configuration Tool

Advanced Mode 88
BTCall Parameters 100
debugging 100
Driver Parameters 91
file locations 95
help 95
IP call control parameters 108
parameter grouping 88
protocol options 84
running 93
Wizard Mode 62
Wizard Mode defaults 84

Copying license files 47
Creating text files 40, 46

D
Debugging

Bfv API 100
Driver

Configuration Tool parameters 91
reconfiguring 92, 98
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E
Email activation 45

F
Fax activation 45

G
Grouping parameters, Advanced Mode 88

H
Hardware information, Wizard Mode 64
Help

Brooktrout Configuration Tool 95
Hide Advanced button 125
Host Based Fax

Configuration Tool 103
SR140 module unavailable 104

I
IP Call Control

modules parameters 108
SIP parameters 109
T.38 parameters 122

L
License

activation successful 37
adding 35, 46
authenticity 30
automatic activation 35
backup up files 51
copy files 47
email activation 45
fax activation 45
file access 47, 54, 60
removing manually 51
serial number 51
status 37

License Activation Center
unavailable 38

License Activation Wizard
activation methods 33
automatic activation 35
email activation 45
fax activation 45
license keys 35
web activation 39

License button 104
License files

backing up 51
location 47
naming 51

License Key
activation 35
already in use 37
invalid 37

License Manager
executable file location 30
starting 30

License serial number 51
License update

SR140 module 103

N
Naming license files 51
Node Lock 40

P
Parameter grouping

Configuration Tool 88
Product Registration

email addresses 36
email request 46
fax request 46
information 36
owner information 36

Protocol options, Wizard Mode 84

R
Reconfiguring the driver 92, 98
Re-hosting 37
Removing licenses manually 51
Request Status tips 37
Request Status window 37
April 2009 145



S
Saving information 40, 46
Show Advanced button 124
SIP parameters, IP Call Control 109
Software information, Wizard Mode 64
SR140 module

licensing information 103
no license 104
Parameters tab 105

T
T.38 parameters, IP Call Control 122
Text file location 40
Tips

request status 37
Troubleshooting

activation center unavailable 38
license key in use 37
license key invalid 37
multiple license problems 30

W
Web activation

instructions 39
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